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Discover a world of 

Visit www.berninausa.com/a200cd/request.html or your
Bernina Dealer to receive a free artista 200E CD-ROM.

imaginatio
n.

artista 200E. 
It’s time to buy the best.
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Discover the artista 200E, and you’ll find innovative,
“world’s first” features you won’t see anywhere
else. For instance, it’s the first and only
sewing and embroidery system in the world
that’s Microsoft® Windows® Powered, 
making it the most intuitive and easiest to
navigate. And the artista 200E doesn’t limit
your embroidery. You’re able to create perfect

embroidery at any size—another Bernina exclusive.
In addition, only artista offers a CD-ROM

drive for easy access to hundreds of 
embroidery designs, and a centrally located
color touch screen for easier viewing. No

wonder the artista 200E won a Consumers
Digest Best Buy Award. Try “the best” today at

your Bernina Dealer, and watch your creativity grow.
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JoAnn Musso has been sewing and designing for
45 years. She teaches and lectures on her embel-
lishment techniques for wearable art, judges
wearable art competitions around the US and has
made several garments for the Fairfield and
BERNINA® Fashion Shows. She exhibits and
sells garments in galleries around the world.

VICKI
TRACY
Turnabout
Jackets 

JOANN
MUSSO
Chocolate
Lace

Amy Barickman, founder of The Vintage
Workshop, has integrated the timeless beauty of
vintage artwork with the accessibility of the
computer and inkjet printer to create an out-
standing variety of projects. Her signature Click-
n-Craft® CD-ROM series and inkjet printables
including fabrics, transfers and canvas will lead
sewing enthusiast to limitless possibilities.

As an Education Consultant for BERNINA® of
America, Jill is the resident master of stitch
manipulation. She loves playing with them,
changing them, and using them to create textured
fabrics for garment and craft projects.

With a background in Art and Home Economics,
Susan is interested in all types of sewing and
crafts and has written several sewing books. She
loves to be creative on paper as well as in fabric
and is the Director of Communications for 
BERNINA® of America, Inc.

After sewing and quilting many years on her
BERNINA® 1130, a friend sold Velina a used Deco
500. Machine embroidery quickly became a
favorite and she progressed quickly into an
artista180E. Velina enjoys creating original proj-
ects that incorporate machine embroidery. She
lives with her family in Birch Bay, Washington.

Jennifer, an Education Consultant for BERNINA®

of America, combines serging, sewing, and
embroidery in many of her updated interpreta-
tions of favorite patterns, many of which incorpo-
rate decorative serger techniques in unexpected
places.

Vicki’s unique sense of style and her obvious love
of sewing and machine embroidery serves her
well as the owner of BERNINA® Sewing Studio in
Lubbock, TX. Her free-wheeling approach to
sewing is evident in her personal motto –
“Lighten Up. Be Fearless. Have Fun.”

W
HO

We Are...
SUSAN
BECK
Managing
Editor

GAYLE
HILLERT
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News

An avid sewer since she was a young girl, Gayle
has  managed to combine her vocation and her
avocation. As Vice President of Education for
BERNINA® of America, Inc. she is responsible for
training, education and testing functions relating
to all BERNINA® products.

AMY
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The Vintage
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MARTHE
YOUNG
Floral
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JO
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Editor

SANDRA
BETZINA
The European
Traveler 

KAY
LYNCH
HICKMAN
Stabilizers

VELINA
WINCHELL
Timing is
Everything

JILL 
DANKLEFSEN
Stitch
Counter 

JENNIFER
GIGAS
A Personal
Touch

As a Card Production Assistant at OESD, Inc.,
Kay’s job is to assist in the development of
designs and embroidery cards for BERNINA®

and OESD, and to create projects using the
embroidery designs. She has a BS degree in
Home Economics Education from Oklahoma
State University.      

Marthe majored in illustration and received a BFA from
The Cleveland Institute of Art. Since1996 she has com-
bined her love of drawing and sewing as a BERNINA®

Resource Trainer in New England. She has designed two
embroidery collections for BERNINA® – Hats and Shoes
and Just Desserts. Her illustrations grace the pages of
several BERNINA® publications, including artista
Sampler and the recently released Tassels & Trims book.

Sandra is the dynamic host of HGTV's Sew
Perfect, and the author of Fabric Savvy, Fast Fit,
and the Power Sewing series of books and
videos, as well as the syndicated Power Sewing
column. She travels all over the United States and
Canada as a lecturer, teacher, and guest on
television sewing shows. 

Currently stitching a collection of purses and
totebags, Jo is constantly on the lookout for
quick, simple projects to share with beginning
seamsters. As Editor for BERNINA® of America,
Jo is instrumental in the production of Through
the Needle.
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Do the events of the day, the week, and the month ever overwhelm
you? Isn’t it a mystery that we now have so many time saving
gadgets and appliances but our lives are more hectic than ever?
Isn’t it special and unbelievably wonderful when we can slow down
time and pursue our creative interests? Please stop for a while
when you receive your Through the Needle magazine to pour your-
self a cup of tea or coffee, sit on a comfortable couch or chair, put
your feet up and take time to relax a moment and enjoy some quiet
time for yourself.

In addition to the articles and projects in this issue of Through the
Needle, I want to let you know of some fabulous new things from
BERNINA®. Take a look at the affordable new ways to enter the
BERNINA® family—either through the bernette® machines priced
under $500 or through the new activa line of machines—easy to
carry to class because of the lighter weight (approximately 17
pounds), but powerful and packed with stitches and features.

Over the next few months, BERNINA® is introducing several new
presser feet and accessories for you to add to your collection—
Clear Embroidery Foot #39, Free Motion Couching Foot #43, the
Patchwork Foot with Guide #57, and the amazing Buttonhole
Compensation Attachment (shown on page 28 of this issue) that
allows you to sew perfect buttonholes on thick or uneven fabrics.
Visit your local BERNINA® dealer and ask for a demo so you can
see how these accessories can help your sewing. 

One of the cleverest
sewing inventions to
come along is the
“Swiss SewEssential”—
the tool every sewer
must have. Made for
BERNINA® by Wenger,
the company that manu-
factures the famous
Swiss Army Knives, the
“SewEssential” contains 17 sewing tools including a needle thread-
er, seam gauge, bodkin, awl, magnet, needle inserter, rotary cutter,
scissors—all in one handy tool. It is the perfect gift to give your-
self—or a friend.

If you are a quilter and want to stretch your imagination with
embroidery, please look at our artista 185 Quilters Embroidery
Edition that comes with the Straight Stitch Plate and Patchwork

Foot #37 in addition to an embroi-
dery card with outline quilting
designs by Holice Turnbow. If
you have always wanted to
have a BERNINA® for quilting,
yet were intrigued
with the idea of
embroidery as
well, the
185QEE is the
perfect machine
to realize your
dreams.

BERNINA® is proud of its heritage—a company founded 110 years
ago by a genius inventor—still owned by that same family today.
The 165E Heritage Edition is a
testimony to the heritage of
“Swiss Tradition and
American Creativity”. Check
out this machine for
the perfect
marriage of
precision and
quality that
includes both
sewing and
embroidery.
The machine comes with 25 embroidery designs representing
American patriotic designs and Swiss heritage designs.

BERNINA® and Through the Needle—we’re always thinking of
ways to help you slow down time just a bit and indulge yourself in
creativity. If you haven’t seen the book Tassels & Trims, please ask
to see a copy at your BERNINA® store.  Featuring designs from the
Studio BERNINA® Tassels & Trims I and II embroidery collections,
this book is filled with projects for every taste and type of sewing.
The book is 128 pages and comes with a CD of 57 new Tassels &
Trims embroidery designs. You will be sure to find a project that
you just have to make—either for yourself or a friend…another way
to take the “hectic” out of your life for a little while, and replace it
with calm, creativity and cool tassels!

So, enjoy this issue of Through the Needle and take time to enjoy a
few moments of creativity.

BY GAYLE HILLERT
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JoAnn Musso is a
frequent participant in the
annual BERNINA® Fashion
Show and in this article she takes
you through the process of
designing one of her “show-
stopping, real-life” garments. 

Fashion Show Style
After making five Fashion Show garments for the size ten models to
“strut MY stuff” down the runway I decided “That’s enough! I’ve had
it! I want to make one of those fun to design, exciting to make and
drop dead gorgeous outfits for myself!” The only problem was that
I am not a size ten. So, OK, I needed to make one in my size, adapt-
ed to my lifestyle which doesn’t include sashaying down a fashion
show runway but does include a wedding and reception, an artist
friend’s gallery opening, and a cocktail party or two.

Adapting my Fashion Show designs for my life wasn’t difficult since
my garments are always wearable – they’re just a little more elabo-
rate than what suits my needs. My favorite design is always my last
design, so it was easy to go from my 2001/2002 BERNINA® Fashion
Show garment – “Amazing Lace” – to one designed especially for
me. The idea for the original BERNINA® Fashion Show design
revolved around making heavy lace on the BERNINA® artista 180E
embroidery module for the edges of the jacket and a triangle on the
front of the bodice. I selected a bright aquamarine peau de soie for
the jacket and bodice inset and black velvet for the long straight
skirt and bodice, all lined in China silk. The 34 individual black lace
motifs were heavily embellished with black beads and sequins and
edged with heavy black soutache braid to make an elegant, lady-
like evening suit.

"Chocolate Lace" is my real-life adaptation of "Amazing Lace". I
hope you enjoy it, and that it inspires you to make a special occa-
sion outfit designed just for you.

Recipe for

Chocolate Lace 
COLOR:
I always choose a color
combination first. I think it
helps me visualize my fin-
ished design better. You
can select your favorite
color for the jacket, as I
did, and find a dramatic
dark contrast for the lace
and coordinating garments
such as the dark brown I
selected. If you are a bit
timid and don’t want to step
too far “out of the box”, con-
sider making the whole suit in
one color with matching tone-
on-tone embroidered lace.
Solid black, white or ivory is

timeless and stylish. 

PATTERN:
After you have chosen your colors, your next consideration is a
jacket pattern. Choose one you have made before, or select a new
pattern and make a fitting muslin. I like classic clothes – they suit
my lifestyle and, most importantly, my body. I have a perfect jacket
pattern for my figure that I’ve adjusted so the hem meets the widest
part of my hips, making it slenderizing and the right proportion for
my 5’2" body. If you are large in the hips you may want to do the
same. If you are slender you may want to choose a shorter and
more fitted style. Just adapt the pattern to your body before you
start. My favorite skirt and pants patterns are ones I’ve made from
garments I enjoyed wearing so much that I took them apart, creat-
ed a pattern, and sewed them back together again.  

FABRIC:
When choosing fabric, the occasion, weather, and appropriateness
for design all have to be considered. For instance, I will not wear
any fabric that is shiny. It makes me look shorter and wider than I
am because it absorbs the light. I think this is good advice for most
of us who live regular lives. I like dull, matte finishes that can sparkle
with a little beading or show off sophisticated details. Also consid-
er the information on the pattern envelope; a lot of research goes
into that information and it tells you not only the required yardage
but also the recommended weight of the fabric, suggested stabi-
lizer or interfacing, as well as required notions. I use organza or
lightweight, pre-shrunk cotton batiste as stabilizer for almost every-
thing I make.
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LACE:
The next step is to choose a lace motif. I chose design #3 from the
Studio BERNINA® Lace Effects embroidery collection for both my
garments. Make your selection, keeping in mind that the embroi-

dery must be dense enough to show up on the jacket. Make
multiple copies of the printed template for your lace motif,
reversing the image to create equal numbers of “right”
and “left” templates. These will help you decide – with-
out sewing a stitch! – if you have chosen the right
design for your jacket. Cut apart the “paper lace” motifs
and “hop-skip” them around the edge of the neck and
down the front of the jacket pattern, reversing the
motifs on opposite sides of the jacket and sleeves. 

Hoop a medium weight (or two layers of regular
weight) water-soluble stabilizer such as Solvy or Aqua-
Film. Using rayon or cotton embroidery thread, stitch
your first design. Soak the completed motif in hot water

to dissolve the stabilizer, leaving only the beautiful lace.
If no adjustments are needed, hoop another layer of
water-soluble stabilizer and continue stitching.
Note: Several lace motifs can be stitched in
the same hooping using the on-
screen editing features of the
artista.

EMBELLISHMENTS:
Once you have com-
pleted stitching
the lace, dissolve
the stabilizer with hot
water and allow the
embroidery to dry com-
pletely. When you have

your jacket together and have
made any necessary adjustments

you are just about ready for the fun part – attaching the lace
and embellishing it as you like with beads, sequins, and
soutache braid.

Make enough cording in the color of the lace to edge the jack-
et and around the sleeves and belt if you make one. Sew the
cording L" from all edges and press toward the inside of the
jacket, leaving the cording on the edge. This serves as a
guideline for the lace that will be hand sewn against the cord-
ing. Lay out all the lace motifs, pin them in place and hand
stitch each one to the body of the jacket. If you wish to add
beads or other embellishments now is the time to do that. I also
add my shoulder pads before I start inserting the lining.

FINISHING:
The jacket lining is cut the same as the front, back and sleeve
pattern pieces. Put the lining together as you did the jacket.
Machine stitch L" from the jacket and sleeve edges. Press to
the wrong side on the stitching line and hand stitch the fold of
the lining against the cording all around the jacket and sleeves.

Under-Wear

That is what I call the
solid color ensembles
that I wear “under” my
embellished jackets. An
“under-wear collection”
consists of a high-neck
blouse with sleeves, 
a low-neck sleeveless
shell, a camisole, a good
cotton or silk turtleneck
tee or blouse (no collars
on any top, as they
would interfere with the
jacket), a long straight
skirt, a short straight skirt
and a pair of pants. A
good pair of flats, boots,
and heels, plus an
evening bag and hand-
bag. ALL IN THE SAME
COLOR.

If you have these “under-
wear” combinations in
your closet in black,
brown, navy and white –
or your own basic colors
– all you will ever have to
do is make a new jacket
because you will already
have what you need to
wear under it and with it.
If your closet is already
hiding a set of “under-
wear” in the color you’ve
selected for your thread
lace, you may only need
to make a jacket. If not,
consider this the begin-
ning of building a closet
full of solid color pieces
that will allow you to mix
and match your embel-
lished jackets for any
occasion or type of
weather.

5
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ASSEMBLY
INSTRUCTIONS
Note: All seam allowances are ¼"

� Print desired image from Click-n-Craft®

Antique Alphabet CD onto Cotton Poplin fabric
sheet following manufacturer’s instructions. Trim image
exactly around the edges. Remove paper backing.

� Turn all edges of image under ½". Press.

� Apply Steam-a-Seam to the wrong side of the image following manufacturer’s
instructions.

� Center the image on the inner border fabric. Remove paper backing and fuse in place
following manufacturer’s instructions.

� Fuse a piece of fusible interfacing to the wrong side of the image piece.

� Using a satin stitch or other decorative machine stitch, stitch around all sides of the
image.

� Cut a strip of border fabric 1½" wide by the width of the fabric.

� Attach Patchwork Foot #37 or #57 to the machine. With right sides together, stitch
border strip to one side of the image piece using the edge of Patchwork Foot #37 or
#57 as a guide. Trim border even with image. Repeat on the other side. Press border
seam allowances toward image.

� With right sides together, stitch border strip to top of the image piece. Trim ends
even with sides. Repeat for the lower edge. Press border seam allowances toward
image.

� Cut a piece of fabric for the back the exact size of the front piece.

� With right sides together, stitch front to back on all sides leaving an opening on the
bottom for turning. Trim corners and turn right side out. Stuff with polyester stuff-
ing; slipstitch opening closed.

By Amy Barickman

MATERIALS 
& SUPPLIES

• Image from Click-n-Craft®

Antique Alphabet CD-
ROM

• Sheet of Click-n-Craft®

Cotton Poplin

• 9½"w x 10½"h piece of
fabric for inner border 

• ½ yard fabric for outer
border and back

• Lightweight fusible inter-
facing

• Polyester stuffing

• Construction thread, such
as Mettler Metrosene

• Decorative thread

• Hand-sewing needle

• Sheet of Steam-a-Seam®

fusible web

• Rotary cutter, mat, and
quilters’ ruler

• Patchwork Foot #37 or
Patchwork Foot with
Guide #57

• BERNINA® Iron or
Ironing System

Alphabet
Pillow
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Visit The Vintage Workshop at www.thevintageworkshop.com and sign up to receive free newslet-
ters! These bi-monthly newsletters are full of ideas and projects that use beautiful vintage images! A
new feature allows you to preview the images on CD-ROMS before purchasing! The Vintage
Workshop  also offers a complete line of imprintable fabrics, papers, iron-on transfers and more!

MATERIALS & SUPPLIES

• Embroidered alphabet letter
from Antique Alphabet
Letters by The Vintage
Workshop embroidery 
collection

• Purchased linen sachet bag

• Sheet of Steam-a-Seam®

fusible web

• Decorative thread

• FrayBlock™

• Purchased sachet

• Scissors

Sachet Bag
ASSEMBLY INSTRUCTIONS

� Using decorative thread and a decorative machine stitch, stitch
around the top of the sachet bag.

� Trim embroidered alphabet letter to include a ½" border on all
sides. Apply FrayBlock™ to all edges of the stitching. Let dry
completely.

� Using sharp scissors, trim alphabet letter close to the edge.
Reapply FrayBlock™ to all edges of the letter.

� Following manufacturer’s instructions, fuse Steam-a-Seam® to the
wrong side of the letter. Center the letter on the bag and fuse in
place following manufacturer’s instructions.

� Add sachet to inside of bag.

Purchased lingerie bags are made special by adding initials. Consider
using three letters to make a monogram and adding them to the bag
as above. To make a custom bag, embroider the letters on fabric and
then make the bag in any size that pleases you!

7
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What I like most about this jacket is the simplicity of the design
(only 3 pattern pieces) and the versatility or maybe reversibility

(two jackets in one). It is a blank canvas for all your
embellishment ideas, be they appliqué, embroidery,
piecing, or any combination of these. So how can

you make what was designed to be a lined
jacket from only one layer of fabric? Sew all

the seams, wrong sides together, and bind
them with the bias binder. Although this
premium attachment has been my favorite
tool for years, I can always find one more

way to use it. And in this case, the binding
adds a contrasting fashion element to the

design. You will love the way this
lightweight jacket completes an
outfit. The simple construction,

wearing ease, and comfort will make this
jacket your new favorite. With so many ways
to mix fabrics, your collection of interesting

combinations can leave you sleepless with ideas.

By
Vicki
Tracy

NOTE: 
The pattern includes directions for 

making a reversible jacket. The 
construction steps that follow are for a

one-layer jacket with bound seam
allowances as a design detail on the out-

side of the jacket. 

Fabrics shown in the original pattern
are from the Gothic Grace collection

by Kaye England. View it at
www.benartex.com.



INSTRUCTIONS:
With wrong sides together, match shoulder seams and serge using a 4-thread
balanced stitch.

Cut contrasting fabric into bias
strips according to the directions
of the Bias Binder Attachment
#84. Attach the Binder Attach-
ment and Binder Foot #94 to the
machine.

Following the directions of the
binder, bind the exposed shoul-
der seams.

Bind the lower edges of the sleeves.

With wrong sides together, serge
the sleeves to the armhole edges.
Bind the resulting seam.

With wrong sides together, serge
the underarm seam from the
lower edge of the sleeve to the
lower edge of the jacket. Repeat
for the other side.

Bind the underarm and sleeve
seams from the lower edge of the

jacket, continuing a binding strip of about 6" off the end of the sleeve edge.
Tie a knot in the end and tack the knot to the sleeve binding, forming a
loop.

Starting at the right front hem edge, bind around the hem, up the left
front, around the neck edge, and down the right front edge, stitching a 6"
strip off the lower right front. Tie a knot in the end and tack the knot to
the hem bindings, forming a loop. Option: Sew a button between the knot
and the loop.

Sew about 36" of bias cord. Tack
it to the back waist for an addi-
tional design feature and to con-
trol the fullness of the jacket
back. Stitch embrodiered "but-
tons" over the ends of the
attached bias ties.

Note: “Buttons” were embroidered
on dark heavy weight Cut-away
stabilizer. The design is avail-
able as a free download from
www.berninausa.com. Log on and
go to What's New > Free Downloads
> Free Project Embrodiery Designs.
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BERNINA® SUPPLIES:

• BERNINA® sewing machine and
embroidery module

• BERNINA® serger

• Bias Binder Attachment #84 and
Binder Foot #94

OTHER SUPPLIES:

• Pattern:

- Turnabout Jacket pattern 
by vickitricks design

• Fabric:

Select a fabric for the jacket front that
looks good on both sides because the
wrong side will turn back for the
“lapels.” For the sleeves, look for
something unusual. I am always
attracted to lace, sheer, or loosely
woven fabrics that could require a
lining if used in another part of the
garment. These fabrics can add
interest, texture, and drama and are
perfect for sleeves because the "fear of
sheers"  is not an issue.

- ½ yard contrasting fabric for bias
binding Option: For a scrappy look,
cut bias binding from an assortment
of fabrics and piece randomly. It is
not the first thing that will be
noticed about the jacket but it will
make an interesting and quirky
statement.

- 1¼ yard 45" fabric for sleeves or 
¾ yard 54"-60" fabric

- ¾ yard fabric for jacket fronts

- ¾ yard fabric for jacket back

• 4 cones of serger thread

• YLI 30 wt. cotton variegated thread
for binding

• Heavyweight Cut-Away stabilizer by
OESD

I S S U E  1 1
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By Sandra Betzina

When traveling in Europe, what pieces should you take
with you so that your look is chic and does not scream
“tourist”? What pieces can you pack so that you are truly
traveling light – in case you have to carry your own lug-
gage? How can you be prepared for all occasions and any
type of weather without lugging half of your closet?

Start with a good travel bag – one that is very lightweight
so that once it is packed you can still lift it easily. If you are
not used to carrying a shoulder bag, your travel bag
should have wheels.

Buy a good quality suitcase that will travel well without the
zipper giving out when you stuff it after shopping. In the
bottom of the bag, pack a folded suitcase which can
accommodate all your extra treasures on the trip home –
this will prevent you from looking like a bag lady at the
airport, struggling with three or more shopping bags!
Preferably your travel bags should match in color. A dark
color is less “touristy” looking. Tie on a colored ribbon or
scarf so that you can easily identify your luggage at bag-
gage claim. 

Black is the color favorite for most Europeans so if you
want to blend in, let black, charcoal gray, or dark brown be
the predominant color of your travel wardrobe. Select just
one “color story” for your trip, since each additional color
grouping adds weight to your suitcase. Layering is the key
to warmth without bulk, and a limited color palette
ensures that everything in your suitcase will go together.
The following is a suggested list of items to take on your
next trip abroad:

• 2-3 cotton t-shirts – Invest in a well-cut, flattering, black
t-shirt, maybe a wrap style if you can find one. It will
dress up any skirt for evening.

• 2 sweaters – One dark, one colored. If you are always
cold, pack a black cashmere sweater; it will not show dirt
and can be worn over anything. 

• 1 pair of dark pants 

• 1 dark skirt – Preferably full, with
an elastic waistband, so that it is
comfortable to wear on the
flight. I always take a black
straight skirt made using my
pattern Vogue 7333.
Constructed of sueded
microfiber, also called
stretch Moleskin, it never
wrinkles.

• 1 beautiful shawl  - This plays multiple
roles, adding a shot of color, providing extra warmth,
acting as a pillow on the plane and as a lightweight
blanket if you need it; it’s also a classy cover-up when
you go through Customs.  

• 2 pairs of shoes – Extra shoes are heavy and take up
valuable packing space – besides, they’re fun to buy on
a trip! 

• 1 pair of comfortable but chic boots or closed shoes
for walking

• 1 pair of comfortable but dressy flats or low heels for
dinner

• 2-3 pairs of fun socks

• 1 hat – One that matches your shoes, boots, or bag, and
looks good with the shawl – perfect for bad hair days,
or to give you a pulled-together look. 

• 1 pair of gloves – In a color that relates to the shawl

• 2-3 small colored scarves – To liven up a sweater or
raincoat. 
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• 1 vest – Great as a good-looking third piece, and warm
if made of boiled wool. 

• 1 pair of tights – To wear under skirt or pants if the
weather is cold. 

• 1 thin raincoat – One that will fit over a t-shirt and
sweater without being too bulky; preferably with a hood. 

• 1 bag – The only purse I ever take on a trip is a rendi-
tion of my pattern Vogue 7862. It has an easily accessi-
ble pockets in the strap for passport and tickets, leaves
your hands free for shopping, lies close to the body with
hidden zippers to discourage pick pockets, and hangs
across the body making it easy on the shoulder and
impossible to snatch. For traveling, I turn the bag around
so the zipper faces my body. (See Sidebar.)

If this does not seem like much to take, it isn’t! If you get
sick of your limited wardrobe, you can always pick up
something new, which, of course, you will do anyway. 

On the plane, wear one of the t-shirts and one of the
sweaters – you can take off the sweater if you are hot. In
addition, wear a skirt or pants with an elastic waist, the

boots, and the raincoat. Pack
everything else in your

suitcase, rolling
up each item
to reduce
wrinkles. 

Pack the following in your carry-on bag:

• prescriptions

• toothbrush

• extra glasses or contact lenses

• jewelry – keep to a minimum – another fun shopping
item!

• 2-3 good paperback books (lightweight, and
expensive to buy overseas)

• camera

• a small notebook and pen

Carry your passport and your airline
ticket on your body – in your shoulder
bag or around your neck in a small flat trav-
el wallet. (See www.berninausa.com for an
easy-to-make version.) Write all your
important numbers – your visa, passport,
traveler’s checks, and telephone num-
bers on a piece of paper. Pull up the
inner sole in a shoe or boot and tape
this information there. You won’t be
losing a shoe and no one would think to
look there. 

One last piece of advice: Wear sexy bras when traveling in
Europe – you will be treated with much more respect if
you end up in the hospital!

This terrific everyday or travel purse rides comfortably

over the shoulder and across the body. Two zippered

compartments in the strap separate keys and cell

phone from the rest of the contents of the purse; folds

flat for packing. Can be made in less than two hours;

Invisible Zipper Foot #35 makes inserting

invisible zippers quick and easy!

Pattern includes regular and petite ver-

sions (the petite size has a 2" shorter

strap and is ½" smaller all around).

Suggested Fabrics: leather, syn-

thetic leather and suede, brocade,

and medium weight cotton.
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Inspired by the 
beautiful 3-dimensional aspect 
of traditional Baltimore Album

quilts, this project uses a variety of
machine techniques.

Note: Machine wash and dry all prior to cutting.
All seam allowances (SA) = ¼" unless specified otherwise.

Fabrics
The cotton fabrics (see supply list) selected to be used with the
black felt background are by Benartex and include selections from
several collections: Yours Truly by Eleanor Burns, Anniversary
Florals by Eleanor Burns, and Age of Innocence collection by Shar
Jorgenson. To view these collections, go to www.benartex.com
and to purchase them, visit your local BERNINA® Dealer and/or
quilt shop.

Bias Strips
Fold all bias strips – EXCEPT handle strip – right sides together
lengthwise. Sew into tubes using Patchwork Foot #37 or
Patchwork Foot with Guide #57 and a ¼" seam allowance. Turn
all tubes and press seam to center back.

Lay the three narrow bias tubes side-by-side and pin top raw edges
to the Cut ‘n’ Press Mat or ironing board. Slowly braid to 7½".
Carefully transfer to sewing machine and staystitch ends; trim
excess from ends. Steam press, turning under ½" at each end of
braid. Set aside. 

Background
Steam and press black wool felt background fabric; using tempo-
rary spray adhesive, bond stabilizer to wrong side. Using a chalk
marker, mark the fabric as shown.
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by Marthe Young
Finished Size: 23" x 23"



Basket Weaving
Cut a 1" x 8" strip of Steam-a-Seam 2. Remove protec-
tive paper from one side. Place vertically on background
fabric inside the right hand basket line; press in place. 

Pin the eight 10" strips to the lower edge of the basket,
placing raw edges ¼" above the line and evenly spacing
them across the 6" width of the basket. Pin them so that
they are hanging down with the wrong sides of the strips
showing. Straight stitch across all strips using the chalk
line as a guide. Backstitch at each end, or use the
Securing function of your machine, if available.

Repeat this step on left side of basket, using the ten 8"
tubes and leaving the long ends hanging off to the side.

Fold strips over basket area, weaving strips over and
under. Along right side, trim raw ends ½" beyond the
chalk line; finger press ends under. Remove protective
paper from Steam-a-Seam 2 and press woven tubes to
hold raw edges in place.

Pin raw edges of tubes; do not trim excess. Straight stitch
across the top of the basket using the chalk line as a
guide. Trim excess tubes to within ¼" of stitching line.

Using the ¾" Clover
bias tape maker,
make handle as
shown. Saturate bias
strip with starch; let
dry. Steam and press
the tube, curving it
to create the handle
shape. Pin handle 
to the background
fabric. Stitch in place
using Edgestitch Foot
#10/10C: move needle two positions to the left and
stitch handle down along one side, then move needle two
positions to the right and stitch down opposite side.

Cut a 6½" x ½" piece of Steam-a-Seam 2, and press it to
the top raw edges of basket. Remove protective paper,
position the braid, and press firmly. Basket is now done!
Leave stabilizer on back.
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Supplies
• Background fabric, wool felt, 16½" square
• 16½" square of cut-away stabilizer
• 505 temporary spray adhesive
• 1 yd tan cotton for basket, cut into bias strips:

- eight 2" x 10" strips; can be pieced
- ten 2" x 8" strips
- three 1¾" x 10" strips
- one 1⅜" x 14" strip for handle

• Fat quarters of 4 contrast fabrics, 
2 red and 2 yellow

• Fat eighths of 2 green fabrics.
• ¼ yard of contrast cotton for inner border, cut

to 1½" x 24" to allow for mitered corners
• Batting, 24" x 24" square 
• Backing fabric, 24" x 24" square
• ¾" Clover bias tape maker
• #6 beads, 2 contrasting colors
• Monofilament thread

• Chalk marker
• 3-5 spools contrasting thread for stems, 

mini-flowers and appliqué
• 3 small buttons (¼"-½") for carnations
• Walking Foot #50
• Patchwork Foot #37 or Patchwork Foot with

Guide #57
• Edgestitch Foot #10/10C
• Button Sew-On Foot #18
• Open Embroidery Foot #20/20C
• Clear Foot #34/34C
• Bias Binder Attachment #84 (size 26-30mm)

with Binder Foot #94
• Embroidery (Gold Latch) Bobbincase 

(artista 180/185/200 only)
• Quilting needles, size 90/14
• Cut ‘n’ Press Mat (optional)
• Steam-a-Seam 2
• Spray starch or sizing
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Flowers
Note: Refer to pattern for placement as needed.

Tip: For the following flower and stem stitching, use the
Embroidery (Gold Latch) Bobbincase on the artista
180/185/200. On machines with a maximum 5mm stitch
width, thread the eye of the bobbin case.

Carnations: 
Layer five to six 2" cotton squares (flannel works great)
right side up. Select an eyelet stitch and use Clear Foot
#34/34C to stitch an eyelet in the center of the pile of
squares. Trim the edges of the stack of square into a cir-
cle. With sharp scissors, create petals by cutting from the
outer edge to the eyelet about every ⅜". Snip into the
raw edges about ¼" all around the circle. Repeat this
process for all three carnations. Toss carnations into
washing machine and dryer with your laundry! Set aside
to attach later. 

Bellflowers: 
Fuse Steam-a-Seam 2 to
wrong side of red, yellow
and green for flowers
and leaves. Trace pattern
pieces onto paper back-
ing of fused fabric; cut
out and set aside. Do not
fuse the circles (flower centers).

Stems: 
Using chalk, draw stem
lines onto fabric as
shown. Thread needle
with green or brown
thread and select a stitch
for stems. I like to use a
satin stitch and the triple
straight stitch in differ-
ent areas. Stitch all
stems.

Flower Centers: 
(3-D buds) At the top of
the basket: Press circles
in half, wrong sides
together. With folded
edge at top, swing each
side down to bottom and
pin in place on back-
ground fabric, scrunch-
ing together. Tack down
with a zigzag stitch along
the lower raw edge. Peel away paper backing of tulip
shape and press down over folded flower center; fuse in

place. Tip: Staystitch close to raw edge across the top of the
tulip shape to compress fabric bulk and keep satin stitch
from skipping. Satin stitch (width = 2.5mm, length =
0.3mm long) around this shape.

Other Flowers: 
Fuse other flower shapes and leaves where desired. Using
Open Embroidery Foot #20/20C and a single blanket
stitch (width and length settings as desired), stitch
around each shape. Be sure to pivot frequently when
stitching the large curve, as shown, to avoid stitch gaps.
Tip: Use these features, if available, when pivoting along
curves and at corners: Securing function, Needle Position at
far right, Needle Stop Down function, and the Free Hand
System.

Use a triple straight stitch for the stamens in the bell-
flowers. Beads will be attached later; see below.

Little Leaves: 
Select the "football"
stitch, if available (artista
stitch #407; 155 = #46,
145S = #45) and engage
the Pattern Repeat func-
tion 1x. For other
machine models, practice
increasing and decreasing
the width of the satin
stitch to create a leaf
shape. Stitch small leaves
as desired; see photo for guidance.

Baby Flowers: 
Select the "pompom" stitch (artista stitch #651) and
adjust stitch width to 9mm and length to 2.5mm. Tip:
Save this stitch in your Personal Program so that you can
use it again later. For other machines, a similar effect can
be achieved using the "star" or "daisy" stitch available on
most models. With contrasting thread, stitch baby flow-
ers as desired.

Berries: 
Attach Button Sew-On Foot #18 to the machine and
thread needle with monofilament. Select the button
sew-on stitch, if available (artista = #60, 145S = #13,
135SPE = #12). Other models select double overlock
stitch #8, set stitch length at 0mm, and engage the
Securing function. Put needle through center of bead
and lower the presser foot. Attach berries as desired.
Note: This technique will not work with small seed
beads; beads must be size 6 or larger. Keep these settings
for use with the next step.
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Fluffed Carnations: 
Place a button in the
center of each carnation.
Using the above settings,
turn the handwheel by
hand to lower the needle
into each hole of the but-
ton; adjust stitch as
needed to avoid breaking
the button, needle or both! Add buttons as desired, cre-
atively or to hide oops! areas of stitching! Use these set-
tings to attach a bow if desired.

Finishing 
Turn your basket of flowers into a pillow, wall hanging,
or use as a block in a larger quilt. To make a wall-hang-
ing like the sample, strip-piece around the embellished
square using 1½" wide strips, add a wider pieced border.
Layer the piece over cotton batting and cotton backing
and quilt as directed below. Finished size is 23" x 23"
square; the size can be changed by altering the width of
the borders.

Using Walking Foot #50, sew around the outside of the
background fabric and stitch-in-the-ditch along the bor-
ders. Feel free to do some freemotion stippling on the
background fabric around the basket and flowers.

Thread the needle with monofilament and fill the bob-
bin with a color to contrast with the background fabric.
Select the hand-look quilting stitch (artista = #346, 155
= #62, 153QE = #21, 145S & 135SPE = #20, 125S =
#13). Models that do not have a hand-look quilting
stitch can use a straight stitch, with contrasting thread in
the needle and bobbin. Set the Walking Foot guide at 
3¾". Stitch around the background, aligning the raw
edge of the quilt with the Walking Foot guide, creating
a frame around the motif.

Attach the 26-30mm
Binder Attachment
#84 and Foot #94
to the machine.
Heavily starch a
length of 30mm
(1⅛") wide bias;
bind edges of wall-
hanging following
the instructions in-
cluded with the binder.  

Use the 26-30mm BERNINA® binder (attachment #84,
foot #94) and a 30 mm (1⅛") strip of heavily starched
cotton bind the edges and make the piece into a wall
hanging. I LOVE my BERNINA® Binder Attachment;
it creates a finished binding of about ⅜".

I S S U E  1 1





17

The Spring 2004 International Quilt Festival in
Rosemont, Il was the setting for the third annual
Bernina Quilt Leadership Award. Gayle Hillert,
Vice President of Education and Training for
Bernina of America, Inc., bestowed this honor on
Caryl Bryer Fallert, internationally known quilter
and textile artist.

The Bernina Quilt Leadership Award is awarded to
one quilter each year for his or her outstanding con-
tributions to the quilt industry by promoting the art
of quilting and sharing his or her enthusiasm and
love of quilting through seminars, publications, and
other avenues.

No stranger to winning awards, Caryl is best known for her organic, curved seam
designs, including Corona II: Solar Eclipse, which was voted one of the 100 best
quilts of the 20th Century. In 2002, Caryl was selected as one of the 30 most
influential quilt makers in the world. She is the only three-time winner of the
coveted American Quilters Society Best of Show Purchase Award, and her quilts
have won Best of Show in more than fifteen other national and international
exhibitions. Special Awards include the National Quilting Association
Masterpiece Quilt Award (1986), the International Quilt Association Master
Award for Contemporary Artistry (2002) and Master Award for Machine Artistry
(1997).

Caryl’s business, Bryerpatch Studio, is located in northern Illinois and is where
she creates art quilts using hand-dyed fabrics and abstract art techniques. For an
in-depth look at her studio and her work, log onto www.bryerpatch.com. Along
with designing and making quilts, Caryl has created several lines of fabric for
Benartex Fabrics. To see these beautiful collections, visit www.benartex.com and
select Glacier Park in the Fabric Gallery.

Soaring Compliments - 2002

Caryl Bryer Fallert

Splendor in the Grass - 2002

Hidden Influence #2 - 2003
Gayle Hillert presents Caryl with the BERNINA

Quilt Leadership Award in April 2004.
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Using Stabil-Stick for 
Non-Hoopable Items

• Cut a hoop-sized piece of Stabil-
Stick.

• Hoop the Stabil-Stick with the
slick, shiny paper side up.

• Place the hoop template inside
the hoop, and mark the horizon-
tal and vertical positioning lines
on the bottom side of the hooped
stabilizer with a water-soluble
marking pen. You will find it help-
ful to hold the hoop up to the
light to see through the stabilizer.
Photo 1

• Use a pin or other sharp object to
score a large rectangle through
ONLY the top paper layer of the
hooped stabilizer.

• Remove the paper backing to
expose the sticky side of the stabi-
lizer. Photo 2

• Trace the horizontal and vertical
lines onto the front of the stabiliz-
er. Tip: A pencil sometimes works
better than a water-soluble mark-
ing pen when tracing on the sticky
adhesive. Photo 3

• Mark the horizontal and vertical
axis of the embroidery design on
the garment/project to be
embroidered.

• Place the wrong side of the fab-
ric/project onto the exposed
sticky stabilizer in the hoop,

18
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OESD proudly introduces its newest line of

adhesive backed stabilizers: Cut-Away

Stabil-Stick, Tear-Away Stabil-Stick, and

Aqua Mesh Plus. One – or more – of these

products is sure to meet your needs for

adhesive-backed stabilizer.

By Kay Lynch Hickman, OESD, Inc.

What sets these stabilizers apart from
other adhesive-backed products? It is not
only the high quality adhesive that is even-
ly applied for the most uniform stability,
but the high-quality, commercial-grade
stabilizers used for the base of each type.
The adhesive releases easily and cleanly
with no traces of residue left on the proj-
ect. Stabil-Stick is available in both cut-
away and tear-away versions; use Stabil-
Stick Cut-Away when working with knits
or stretchy fabrics. Aqua Mesh Plus is a
water-soluble, adhesive-backed stabilizer.
Any residue left on the needle by these
stablizers can easily be removed with alco-
hol or silicone.

Stabil-Stick and Aqua Mesh Plus adhesive-
backed stabilizers were developed for
items that cannot be embroidered using
traditional hooping techniques. These
include:

• irregularly shaped articles, such as caps,
collars, cuffs and socks

• heavy or thick items, such as towels

• stretchy materials, including bulky
sweater knits

• fabrics that are prone to “hoop burn”,
such as napped materials, vinyl and
leather

Aqua Mesh Plus is available on 18" rolls.
Stabil-Stick Tear-Away and Stabil-Stick Cut-
Away are available as precut sheets and on 7"
and 11" inch rolls. Check with your local deal-
er or visit www.embroideryonline.com.



matching the horizontal and ver-
tical markings on the garment/
project with those on the hooped
stabilizer. Items can be reposi-
tioned as needed to line up the
markings. Photo 4

• Gently finger press as much of
the fabric/project onto the sticky
stabilizer as possible. Photo 5

• Embroider the design.

• Remove the hoop from the
machine and the stabilizer from
the hoop.

• Carefully lift the sticky stabilizer
away from the reverse side of the
garment. Gently tear away
excess if using Stabil-Stick Tear-
Away, or carefully trim away
excess if using Stabil-Stick Cut-
Away.

Stabil-Stick may also be used as a
stabilizer when hooping the stabi-
lizer with the project. This elimi-
nates the need for adhesive sprays,
temporarily bonding the fabric and
stabilizer together to prevent the
layers from shifting.

Using Stabil-Stick for
Hooped Items

• Position the fabric wrong side up
on a flat surface. Take care not to
stretch the fabric; the fabric
should be in its natural, relaxed
state.

• Cut Stabil-Stick larger than the
size of the hoop to be used.

• Remove the paper backing from
the adhesive and carefully posi-
tion the Stabil-Stick on the wrong
side of the fabric.

• Turn the fabric over and gently
finger press the fabric and Stabil-
Stick together.

• Hoop the fabric and the stabilizer
together as one and embroider
the item.

• Gently lift the stabilizer away
from the fabric and cut or tear
the excess away.

Aqua Mesh Plus

If you wish to use a sticky-backed,
water-soluble stabilizer, try Aqua
Mesh Plus, a water-soluble stabiliz-
er used for embroidering small,
non-hoopable items. Use two lay-
ers for the best results and follow
the directions on previous page for
using Stabil-Stick for Non-Hoop-
able Items. After embroidery is
complete, simply soak away the
remaining stabilizer on the back of
the fabric. 

Using Stabil-Stick and
Aqua Mesh Plus with the
Giant Hoop-It-All 

Any of the sticky-backed stabilizers
can be used with the Hoop-It-All
Giant Hoop.

• Cut a 23” length of Stabil-Stick
Cut-Away, Stabil-Stick Tear-Away,
or Aqua Mesh Plus.

• Remove the paper backing and
place the stabilizer sticky side up
on a flat surface. Photo 6

• Center the Giant Hoop-It-All on
the sticky stabilizer and press
down firmly. Photo 7

• Turn the hoop over and firmly
finger press to adhere the stabi-
lizer to all surfaces of the hoop
back.

• For best results, wrap the upper,
lower, and right side edges of the
sticky stabilizer around and to the
top of the hoop. This will help
keep the stabilizer securely in
place. Photo 8

• Trim the excess stabilizer from
the side of the hoop that attach-
es to the embroidery machine.
Photo 9
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This cute clock is quick to make and 
a great gift or accent piece. Match any décor, theme, holiday, 
or hobby. The face can be fully digitized and stitched on an 

embroidery system, or it can be made using a sewing machine, 
substituting decorative buttons for the numbers. 

Finished Size:approximately 8" x 8"

by Velina Winchell

SUPPLIES
• sewing & embroidery system 

• embroidery design – sample is
OESD Three Sunflowers #FM335

• 1/2 yard fabric for clock 

• 5" x 5" square of coordinating 
fabric for clock face

• medium weight tear-away 
stabilizer

• temporary fabric adhesive spray
such as 505

• Isacord embroidery thread in
desired colors

• construction thread 

• polyester stuffing

• clock works (1/2" size)

• 5/16" hollow punch or awl 

• paper-backed fusible web* 

• four decorative buttons 
(without shanks)*

• Open Embroidery Foot #20/20C*

• Button Sew-On Foot #18*

• Circular Embroidery 
Attachment #83* 

• serger (optional)

• 3 cones of serger thread (optional)

* Required only if making clock
using a sewing machine without
embroidery.

• Note: The Pillow Clock face is cre-
ated using BERNINA® embroidery
software v4.0. Make adjustments
as needed to adapt the instructions
to other software programs. 
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Digitizing Instructions

Appliqué Placement & Outline
Click View > Hoop; choose Large or Large Oval hoop with
X-Y lines. 

Click on the Circle tool and draw a circle in the middle of
the hoop. Click on the Select tool; right click to access
Object Properties > General. Enter 4.3" in the height and
width boxes; enter 0.00 in the X and Y position boxes;
click OK. There should now be a perfect circle centered in
the on-screen hoop. Click on Outline > Single stitch. 

The circle should still be selected; click Edit > Duplicate.
The duplicated circle is on top of the original and is select-
ed. Click on the Outline Stitch button and select Satin
stitch. Click on the Color tab and choose C2. 

Numbers
Click on the Circle tool; draw a smaller circle inside the
first one. In Object Properties > General, enter 3.5" in the
height and width boxes and 0.00 in the X and Y position
boxes; click OK. Click on Outline > Single stitch. This is the
number placement circle.

Right click on the Lettering tool. In Object Properties,
choose a lettering style. Click on Center Justification. Click
in the Lettering box and enter 12. Click OK and click on
the screen near the 12 o’clock location. 12 will appear;
adjust size in Object Properties if needed. Repeat for the
3, 6, and 9 o’clock positions. 

Right click on the Lettering tool; click on Select Character,
choose the asterisk (*) symbol; click OK; click OK again.
Place the asterisk near the 11 o’clock position and select
color C4. While it is still selected, click Edit > Duplicate (or
press Ctrl + D). The duplicated asterisk is selected; move it
to the 10 o’clock position. Continue to duplicate asterisks
for the 8, 7, 5,  4, 2, and 1 o’clock positions. 

Select the Open Curve tool. Click above the 12 and drag
straight down below the 6; click and press Enter. Select the
line and right click to access Object Properties > General.
Check that the location of the line is 0.00 in both X and Y
boxes. Click OK. Select color C12. This line will be used
as a guide for positioning asterisks. 

Select the line. Right click to open Object Properties; enter
30 in the Rotate By box; click OK. Select the 11-asterisk;
center it where the line intersects the placement circle. Also
center the 5-asterisk.

Select the line, open Object Properties, and enter 30 in the
Rotate By box. Click OK. Center the Select 10-asterisk and
the 4-asterisk.

Select the line, open Object Properties, and enter 60 in the
Rotate By box. Click OK. Center the Select 8-asterisk and
the 2-asterisk.

Select the line, open Object Properties, and enter 30 in the
Rotate By box. Click OK. Center the Select 7-asterisk and
the 1-asterisk.

Select the line; press the Delete key. Select the placement
circle; press the Delete key. 

Center Design & Clockworks Hole
Click file; insert desired design, reducing to fit as needed. 

Click on the Circle tool; add a circle in the center of the
design. Right click to access Object Properties > General;
enter 0.46 in the height and width boxes and 0.00 in the
X and Y boxes. Click OK. Select the circle and select
Outline > Satin Stitch. Right click to access Object
Properties. In the Outline Stitch tab reduce the width of the
satin stitch to 0.07". Select a thread color that coordinates
with the center of the clock face. 

Print two copies of the design. Cut a paper template from
one copy by trimming the paper
from around the outside edge
of the large satin stitch circle. 

Transfer design to embroi-
dery machine.

Cutting
Instructions
Clock Fabric:

Cut four 7" x 7" squares

Cut two 11/2" strips across the width of the fabric (44")

Cut one 5" x 5" square for face

Assembly Instructions
Note: All seam allowances are 1/4".
The clock is essentially two completed pillows stitched
together with clockworks slipped between them.

Embroider Front Pillow (Clock Face)
Back the 7" x 7" square of clock fabric with medium
weight tear-away stabilizer, bonding the two together with
temporary adhesive spray. Hoop in large hoop. Slide two
pieces of medium weight tear-away stabilizer under the
hoop. 

Embroider the appliqué placement circle (color C1).
Remove the hoop from the machine, but do not remove
fabric from hoop. Using the printed template created ear-
lier, cut a circle from the 5" x 5" square of clock face fab-
ric. Spray the back of the circle with temporary adhesive
and position it inside the stitched placement circle. Smooth
in place. Return hoop to machine and complete the
embroidery design. Remove stabilizer from the outside
edges of the clock face, but NOT from the inside. Cut the
fabric from inside the small center circle using a 
5/16" punch or awl. 
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Assemble Front Pillow 
Join the two 11/2" strips together to make one very long
strip. Finish one long edge with a serged rolled hem, or
turn under 1/2" and zigzag hem in place. Gather the other
long edge; pin to the right side of the pillow front, over-
lapping the ends approximately 1" at the lower edge of
the clock. Trim the strip and finish the short ends by turn-
ing under 1/2" and zigzagging. Stitch. 

Cut a 1/2" slit in the center of a second 7" x 7" square of
clock fabric; this is now the back of the front pillow. Place
it  right sides together with the embroidered front of the
pillow; sew along the bottom edge, leaving an opening
approximately 11/2" long.

Press seam open and turn to the right side. Stitch around
remaining three sides with wrong sides together. 

Very lightly stuff the pillow front around the clock face;
leave opening for making adjustments later. 

Assemble Back Pillow 
Stitch the two remaining 7" x 7" squares together along
bottom edge only, leaving a 11/2" opening for stuffing. 

Press seam open and turn to the right side. Sew remain-
ing sides wrong sides together. 

Lightly stuff pillow back; leave opening for making adjust-
ments later.

Assemble Clock 
Stitch front pillow to back pillow, right sides together,
leaving the bottom edge open for turning. 

Turn pillow right side out. Add or remove stuffing from the
pillows as needed. Note: Avoid leaving too much stuffing
under the clock face as it may obstruct movement of the
clock hands. Hand or machine stitch stuffing openings in
front and back pillows closed. 

Insert clockworks according to instructions. Stitch the bot-
tom of the clock closed, leaving approximately 2" open
for inserting the battery. 

Attach clock hands and insert battery.



Clock Face without Embroidery
Mark vertical and horizontal placement lines on the right side of one 7" x 7"
square of clock fabric. 

Cut out template A and trace the circle onto the paper side of a sheet of
paper-backed fusible web. Cut around the circle approximately 1/2" out-
side the line. Fuse to the wrong side of the 5" x 5" square of clock face
fabric. Cut out clock face along the line. 

Transfer the number and center position marks from the tem-
plate to the right side of the clock face. Using template B, mark the
center circle.

Select a zigzag stitch; adjust the width to 3mm and length to
satin stitch. Attach Open Embroidery Foot #20/20C and
Circular Embroidery Attachment #83 to the sewing
machine. Place the center of the clock face over the pin of
the attachment; carefully press fabric around pin and
place the rubber stopper on the pin. Adjust the attachment
so stitching will be sewn over the line at the outer edge of the
clock face; stitch around circle. 

Satin stitch around the circle at the center of the clock face. Use
an awl to cut the fabric from inside the small circle. 

Stitch eight satin stitches over the placement dots for 1, 2, 4, 5, 7,
8, 10, and 11, using the Pattern Repeat 8x function if available, and
engaging the Security function at the beginning and end of the stitch-
ing. 

Using Button Sew-On Foot #18, with the shank in the lowest position, and
the button sew-on stitch (or a Universal stitch with a length of 0mm), stitch dec-
orative buttons over the 3, 6, 9, and 12 positions. 

If desired, embellish clock face with appliqué, decorative stitching, etc.

Template
A

Template B
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By Jill Danklefsen

The expanded Stitch Counter feature, unique to the BERNINA® artista 200 sewing

machine, offers several possibilities for simplifying and streamlining practical techniques

such as making buttonholes and chain piecing quilts. It also opens up creative avenues for

building elaborate ornamental patterns using the decorative stitches of the machine. 

Using the Stitch Counter function is
easy and requires only a couple of
steps. First, select the stitch (see chart
at right for choices) and then the
Stitch Counter icon. Sew the
desired length of your line of
stitching. When you have
stitched the desired length (there's no
limit to the size), press the Quick
Reverse button. This records the
length sewn and Auto Stitchcounter
appears on the screen. Now, when the
foot control is pressed, the machine
will sew the programmed length and
stop automatically at the end. The
length will stay programmed for this
stitch until the machine is turned off or
another stitch is selected.

Stitch Counter Possibilities
The Stitch Counter feature does not
work with every stitch but the list of
those that are active with this fea-
ture includes 22 stitches, 2 darning
programs, and 10 buttonhole styles.
The chart at right is a visual refer-
ence for each of these.
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Why Count Stitches?
Good for both practical and decorative techniques, these are a few of the ways you can use the Stitch
Counter feature of the artista 200.

Long Buttonholes
Projects often require a buttonhole longer than the Automatic Buttonhole Foot #3A can stitch. When
this is the case, using the Stitch Counter feature for creating buttonholes that are memorized and
repeatable is the next best option. 

Welt Pockets
Select the straight stitch buttonhole #59 and use for creating openings for welt pockets.

Shirred Curtains
Select any of the buttonhole options and create curtain rod openings in a curtain header.

Measured Length Seams
Program a specific seam length that is repeatable. Use for chain piecing your next patchwork project or
to speed up “assembly line” sewing when making multiples of the same item.

Decorative Stitching 
Consider using the Stitch Counter feature rather than the Pattern Repeat 1-9x function. Nine repeats of
a stitch can be very short. If a longer repeat of a pattern is desired, use the Stitch Counter 
feature—there is no limit on the length that is memorized!

Herringbone Chevron

• Select Stitch #353

• Attach Clear Foot #34C

• Engage Stitch Counter function 

• Stitch about 1H" and touch the Quick Reverse

button to end the measurement and program the

pattern length. The pattern length is now repeat-

able! Stitch until the machine stops to get the full

length of the programmed pattern.

• Stitch and pivot in a “stair step” pattern as shown

in the sample: At the end of each repeat, tap your heel on the foot control to lower the needle into

the fabric for pivoting. Note: Needle Stop Down function cannot be activated with this feature.

• When stitching is complete, use a ruler and fabric marker to mark the connecting diagonal lines

• Select Stitch #633

• Stitch, framing the previous stitching

• If desired, finish the frame with a couched cord. “Razzle Dazzle” by Superior Threads was used in the

sample shown.

I S S U E  1 1



One of the joys of home embroidery is
adding a personal touch to all of our proj-
ects. Whether we are creating labels,
stitching a child’s name on his or her blanket or
monogramming linens, we can never have too
many lettering styles from which to choose.
BERNINA® Embroidery Software expands your
lettering options with 50 preprogrammed alpha-
bets, extensive editing capabilities and automat-
ic digitizing of True Type fonts (Designer Plus
level only). Familiarize yourself with the powerful
lettering tools in your software and take a look at
some unexpected uses for lettering.

Basic Lettering Options 
Note: Information on lettering may be found in your owner’s
guide beginning on page 149.
The simplest way to add lettering to a design file is to select the
Lettering Tool from the Design toolbar and type direct-
ly on-screen. The lettering objects will be generated
with the current lettering Object Properties. 

To format your text as it is added to the design file, press “A”
on the keyboard.
This will open the
Lettering dialog
box from which
you may select
the lettering style,
size, spacing
and justification
desired for your
project. Tip: All
text typed in the
dialog box
becomes one object and will have the same Object Properties.
If you wish to have different properties for segments of the let-
tering, enter that text separately.

Justification
and Baseline
Options
Justification refers to the
alignment of multiple rows of
text typed into the dialog
box. Options include align-
ment to the left, right, center
or justified.

Lettering baselines (the line
along which the lettering is
positioned) may be horizon-
tal, vertical, on a circle or you can create the baseline shape
most suited for your particular project. Tip: For multicolored let-
tering, insert color stops by typing “^” after each letter.

Adjusting Lettering
Stitch Settings
Lettering objects are filled with
satin stitches; the fill can be
quickly and easily changed to
a Step or Fancy fill type. To
change the fill, select the letter-
ing and open the Object
Properties dialog box. Select the Fill Stitch tab; from the stitch
type drop down, choose Fancy or Step. Select the desired fill
type.

Elastic Lettering
Elastic lettering options
reshape the silhouette of the
text. Elastic options include
both curved and straight
shaping.
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Reshaping
Individual letters can be reshaped to provide just the
right look for the project you are working on. To
reshape, select the lettering, select the Reshape tool.

Click on the diamond shaped control point in the center of the let-
ter; click on the letter outline. The boundary control points will
appear. You may move, add or delete points to reshape the
object. When finished, press Enter to accept the changes.

Monogram Magic
Note: Refer to the Owner’s manual for additional information.
Take lettering “outside the box” by adding design elements or mir-
ror merge functions to a basic monogram. Use your newly designed
monogram on garments, linens, as your signature label or scattered
across yardage to create your own embroidered fabric.

Select lettering style

• Press the “A” key to open the Lettering
Properties dialog box. Select a lettering style
from the drop down menu. Tip: Refer to the
Online Manual to preview the entire alpha-
bet and to review recommended minimum
and maximum lettering sizes for the selected
style.

• Type the letter of choice into the text box. Click “OK”.
Click on the design screen to position the lettering. Tip:
Follow the prompts on the status bar at the bottom of the
screen.

• Copy and paste the letter until there are four letters on the
screen.

Mirror Merge

• Select one of the letters; select Mirror Merge
Vertical/Horizontal. Move the duplicates
around until satisfied with placement. Click to
set duplicates.

• Repeat for each of the remaining letters, using a different
placement each time.

• Select the artistic view to preview.
• Return to the design window and save work.

Next steps

• Select favorite design, cut.
• Open a new file. Paste the cut design on

screen.
• Arrange>Add Buttonhole. Position a but-

tonhole in the center of the design. Press
ESC to turn off the buttonhole function.

• Select the buttonhole, open Object Properties and select
the desired buttonhole style. If the buttonhole overlaps the
embroidery, merge to remove overlapping stitches. (Select
the design; select the buttonhole. Arrange>merge button-
hole)

• Group buttonhole and motif. 
• Save motif for future use. Tip: Use decorative buttonholes

along a garment placket, to frame antique buttons on dec-
orator pillows or to create beading trim.

Experiment with various alphabet styles, mirror merge and
wreath layouts for novel monogram options on your next project.
Visit www.berninausa.com to download project instructions fea-
turing embroidered journaling. Go to Sewing Studio > Stitching
Memories for directions for making the scrapbook page on the
previous page.  
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Traditional 3-letter
monogram. First and
middle initials mirror
merged vertically to
form elegant scrolls.

Lace fill placed
behind letter B. Small
rosebud removed
from embroidery
motif and placed on
letter for interest.

Reshaped let-
tering with a
color change
inserted after

each letter.
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New! Buttonhole Compensation Attachment
For use with Automatic Buttonhole Foot #3A, this attachment is the answer to making great-look-
ing buttonholes in heavy or thick fabrics. It improves the feeding of difficult fabrics and takes the
work out of making any type of buttonhole in jackets, coats, and items made from fabrics of vary-
ing thicknesses such as chenille or terrycloth.

TIPS 

• Slide Foot #3A into the Buttonhole Compensation Attachment
and snap it into place before attaching the foot to the machine.

• When attaching the foot, use the FHS (Freehand System), if
available, to get the maximum space between the needle bar and
the stitch plate.

• For making buttonholes in uneven areas such as waistbands,
plackets, and jacket edges, use the Height Compensation Tool in
conjunction with the Buttonhole Compensation Attachment to
get the smoothest feeding.






